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 Oscillating reactions are one of the most interesting topics in chemistry and analytical chemistry. Fluctuations in 
concentrations of one the reacting species (usually a reaction intermediate) create an oscillating chemical reaction. In 
oscillating systems, the reaction is far from thermodynamic equilibrium. In these systems, at least one autocatalytic step is 
required. Developing an instinctive feeling for how oscillating reactions work will be invaluable to future generations of 
chemists. Some software programs have been released for simulating oscillating systems; however, the algorithm details of 
such software are not transparent to chemists. In contrast, function of spreadsheet tools, like Microsoft Excel, is well 
understood, and the software is nearly universally available. In this work, the simulation and visualization of different 
oscillating systems are performed using Microsoft excel. The simple repetitive solving of the ordinary differential equation of 
an autocatalytic reaction (a spreadsheet row) followed by time, easily automated by a subroutine (a “Macro” in Excel), 
readily simulates an oscillating reaction. This permits the simulation of some oscillating systems such as Belousov-
Zhabotinsky. The versatility of an easily understandable computational platform further enables the simulation of the effects 
of linear and nonlinear parameters such as concentrations of reactants and catalyst, and kinetic constants. These parameters 
are readily changed to examine their effects. 
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INTRODUCTION 
 
 Oscillating processes are the basis of life. A well-known 
theme in biology is the circadian cycle, synchronized to the 
light-dark periods of the earth. A great number of other 
biological oscillations have been identified such as 
glycolytic oscillations in yeast and muscles, hormone 
cycles, and insulin secretion [1,2]. In addition, oscillating 
process can be seen in a chemical reaction, which is the 
basis of natural and biological processes. Basically, 
fluctuations in concentrations of one of the chemical 
reaction species (usually a reaction intermediate) create an 
oscillating chemical reaction; such fluctuations  are possible  
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periodicity or non-periodicity under specific reaction 
conditions. As an example, a novel self-oscillating polymer 
was prepared by utilizing the Belousov-Zhabotinsky (BZ) 
reaction [3-6]. Yoshida et al. synthesized hydrogel polymers 
demonstrating rhythmic swelling-deswelling oscillations by 
coupling temperature and pH-sensitive poly (N-
isopropylacrylamide-co-acrylicacid-co-butylmethacrylate) 
gels with non-linear oscillating chemical reactions. Solution 
of synthetized polymer showed a harmonic mechanical 
motion with a constant period [6]. Recently, self-oscillating 
gels have been considered as novel biomimetic materials 
[7]. Accordingly, a novel biomimetic walking-gel actuator 
was designed using self-oscillating polymers and gels. The 
self-oscillating property makes microgels more attractive 
for future developments such as  microgel assembly, optical    
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and rheological applications [3]. 
 Hence, understanding the nature and mechanism of 
oscillating chemical reactions can help us to obtain 
information about other oscillating processes, especially 
biological oscillations. Here, we consider a simple model 
sequence in which the reaction shown in Eq. (1a) is started  
with a pure starting material A. Autocatalysis is a key 
feature of most chemical systems exhibiting oscillations, 
which means the concentration of species increases the rate 
of the growth of  that species [8]. If the reaction product X 
catalyzes a second faster reaction pathway, Eq. (1b), so that 
the reaction will speed up after the fornmation of catalyst X 
[9,10]. 
 A → X                                                                         (1a) 
 
 A  + X → 2X                                                                (1b) 
 
 X  + Y → 2Y                                                                (1c) 
 
 Y → B                                                                         (1d) 
 
There are some common features in reaction mechanisms of 
all known chemical oscillators. During the oscillation 
reaction, an energy releasing occurs. This energy drives the 
oscillating “side show”. In addition, at least two different 
pathways can be followed in the energy-releasing reaction, 
and the reaction periodically switches from one pathway to 
another.  In one of these pathways, a certain intermediate is 
produced, while in another pathway it is consumed, and the 
concentration of this intermediate acts as a “trigger” for 
switching from one pathway to the other. When the 
concentration of the intermediate is low, the reaction 
follows the producing pathway, leading to a relatively high 
concentration of the intermediate (Eq. (1b)). When the 
concentration of the intermediate is high, the reaction 
switches to the consuming pathway, and decreasing in 
concentration of the intermediate occurs (Eq. (1c)). 
Eventually, the reaction reverts to the producing pathway. 
The repeatedly switching of reaction from one pathway to 
the other continues [9,11]. 
 At least the following three requirements must be met by 
a chemical reaction to be the source of an auto-oscillating 
system: (a) the reaction system should be far from 
thermodynamic equilibrium state, i.e., its ΔG (Gibbs free 
energy  difference)  should  be negative and large. (b) There 

 
 
should be at least one autocatalytic step in reaction steps. 
Autocatalytic reactions are chemical reactions in which at 
least one of the reactants is also a product. In this reaction, 
the product catalyzes the reaction, i.e., enhances its net rate. 
(c) At least two steady states  are needed under the initial 
conditions [12]. Even autocatalytic systems can reach to a 
steady state, in which the net rate of the increase of all 
relevant species is zero. In other words, the rate of 
reproduction of species equals to the rate of consumption of 
that species. It is possible to find mathematically by solving 
the resultant algebraic equations for the concentrations after 
setting all the time derivatives is equal to zero. A steady 
state is not necessarily stable and the system evolves away 
from this state by the small perturbations or fluctuations  
always existing in a real growing system [8]. 
 The first report documented about oscillation of a 
chemical system gets back to 1828 by Fechner who 
described an electrochemical cell that produced an 
oscillating current. Periodically increasing and decreasing 
the rate of chromium dissolution in acid was observed by 
Ostwald in 1899. The best-known model of this type is 
today called the Lotka-Volterra model which is mostly used 
to characterize predator-prey interactions, developed by 
Lotka and Volterra in 1920. William C. Bray at the 
University of California, Berkeley, and later Bray's student, 
Herman Liebhafsky, studied the first homogeneous 
isothermal chemical oscillating reaction of iodate, iodine, 
and hydrogen peroxide [8]. The other known oscillating 
reaction is the BZ reaction. The mechanism of the BZ 
reaction was described by Boris Belousov in 1951, and the 
basic frame work of its model (Oregonator) was suggested 
by Field, Koros and Noyes in 1972, and elaborated by 
Edelson et al. Finally the last model was proposed by 
Prigogine and Lefever in 1968 and dubbed the 
“Brusselator” by Tyson in 1973 [8]. After that, different 
oscillating reactions were developed, and their mechanisms 
were studied. In addition, several methods such as 
spectrophotometry, potentiometry, and luminescence were 
used as a monitoring method to investigate the oscillating 
reactions. Among the luminescence methods, 
chemiluminescence   has been employed as a usual method 
in monitoring of oscillating reactions [11]. 
 There are two main advantages to perform a simulation 
rather  than  actually building the design and testing it. First,  
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simulation testing is mostly cheaper and faster than 
performing multiple design tests each time. The second 
significant advantage of a simulation is the level of detail 
that you can get from a simulation. A simulation can give 
results that are not experimentally measurable with our 
current level of technology. Various attempts have been 
made to simulate or model the oscillating reactions. A. B. 
Rovinskii and A. M. Zhabotinsky proposed a mechanism 
for a self-oscillating reaction in the bromate-ferroin-
bromomalonic acid system. The corresponding system of 
seven differential equations is reduced to a two-component 
model. The model concepts correspond well to the 
experimental data [8]. According to the Field-Koros-Noyes 
mechanism and the Oregonator model in the computational 
simulation of the BZ oscillating chemical reaction by 
differential kinetic methodology, the change in the 
concentrations of HBrO2, bromide ion, and cerium ion are 
simulated by Jie Ren, Jin Zhang Gao, and Wu Yang. They 
also studied the effect of variables and parameters, 
especially the rate constant, on the oscillation curve [13]. 
Monika Sharma and Praveen Kumar used the Lotka-
Volterra model to illustrate chemical oscillations with the 
help of a computer program [14]. Daniel E. Zaka, Jorg 
Stelling and Francis J. Doyle described a method for 
determining the sensitivity of the period to the model 
parameters that is straightforward to implement and 
interpret [15]. 
 Despite mass production of “simulations” in the 
literature, we still believe that they are not intelligible and 
enough usable for beginners Therefore simulation of the 
systems in a simple and accessible environment is of great 
importance and can help beginner chemists. 
 One of the spreadsheet applications developed by 
Microsoft is Microsoft Excel. It has a grid of cells arranged 
in letter-named columns and numbered rows for organizing 
data manipulations. It allows sectioning of data to view its 
dependencies on various factors from different perspectives. 
Microsoft Excel has a programming ability, Visual Basic for 
Applications (VBA). This ability allows the user to employ 
a wide variety of numerical methods, e.g., solving 
differential equations of mathematical physics. The Macro 
Recorder is a common and easy way to generate VBA code. 
It records actions of the user and generates VBA code in the 
form  of  a macro. Running the macro lets users repeat those  

 
 
actions automatically. Different trigger types like keyboard 
shortcuts can also be linked to macro and permits users to 
easily execute it. In addition, the VBA code of the macro 
can  be edited by the user [16,17]. 
 Few people have done more to demonstrate the 
capabilities of spreadsheets, specifically MS Excel, for 
scientific data analysis than analytical chemists [9,17,18]. 
De Levie extensively demonstrates the use of Excel to 
elucidate different chemical processes. A. Kadjo and  P. K. 
Dasgupta readily simulated chromatography by a subroutine 
(a “Macro” in Excel) using the simple repetition of an 
equilibration process [19]. 
 The aim of this work is to simulate different oscillating 
chemical reaction models using a simple and easily run 
software. Hence, Microsoft Excel was used for its simplicity 
and universal availability. 
 
SIMULATING OSCILATING REACTIONS 
 
 To simulate an oscillating chemical reaction, the model 
for a chemical reaction must be known. Each model consists 
of the following parts: a chemical mechanism, a set of rate 
equations for the defined mechanism, and a set of 
concentration-time equations for the components.   
 A chemical mechanism is the main part of a chemical 
reaction model. It consists of some elementary chemical 
reactions necessary for the description of how reactants 
produce intermediates and then intermediates combine with 
one another and the reactants. Finally, the products are 
formed. After defining the chemical mechanism, it is 
possible to get rate equations. Rate equations are differential 
equations corresponding to the reaction mechanism and 
yielding the rates of change of all species (reactants, 
intermediates and products) using predefined rate constants 
and initial concentrations. These ordinary differential 
equations can be solved using explicator numerical 
integration methods to get concentration- time equations. 
These equations describe the concentrations of species as 
functions of time [20]. 
 
Ordinary Differential Equations and Numerical 
Solution 
 Using kinetic theory, the concentration-time equations 
of  the  species  in a reaction mechanism can be defined by a 
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system of ordinary differential equations (ODEs). 
Integration of ODEs to any time point allows to calculate 
the concentration profiles corresponding to data acquisition 
times with knowledge of the initial conditions. Explicitly 
integration of the resulting system of ODEs is possible for 
the simple systems such as the first- and second-order 
reactions. However, this type of integration is not possible 
for the majority of multiple step reaction mechanisms such 
as oscillating chemical reactions. In such cases, numerical 
integration is a good alternative. Numerical integration 
allows us to approximate the explicit solution to be 
calculated for any system of ODEs, within limits of 
numerical accuracy. Euler's method is a routine numerical 
integration method. This method uses a form of the Taylor 
series expansion truncated to the first derivative [21]. 
Starting with the concentration at time ti-1, the concentration 
at ti is estimated using the derivative at t (Eq. (2)).  
 
 
 t

dt
tdctctc ii  
)()()( 1

                                                   (2) 

 
It is clear that the accuracy of the approximation is strongly 
dependent on the size of increment magnitude (Δt) and the 
function shape. As an example, for the simple second order 
reaction (Eq. (3a)), ODEs for the components of X, Y and Z 
can be formulized as Eqs. (3b), (3c) and (3d). In addition, 
Eqs. (3e), (3f) and (3g) show the equations applied to 
calculate the concentration profiles of species X, Y and Z. 
 
 
 X  + Y  →  Z                                                                (3a) 
 
 

YX
X ckc

dt
dc

                                                             (3b) 

 
 

YX
Z ckc

dt
dc

                                                                  (3c) 

 
 

YX
Y ckc

dt
dc

                                                               (3d) 

 
 tckctctc YXiXiX   )()( 1                                    (3e)                       

                 
 tckctctc YXiZiZ   )()( 1                                             (3f) 

                     
 
 tckctctc YXiYiY   )()( 1                                             (3g)   

                     
where t is time step and equals the difference of ti and ti -1. 
Because of low accuracy, it is not usual to use Euler’s 
method as described here in modern numerical integration 
routines. Some of the modern strategies such as Runge-
Kutta and Bulirsch-Stoer methods are used. Those include 
using higher order terms of the Taylor series expansion or 
calculating the first derivative at multiple points [21]. The 
Runge-Kutta methods are a family of implicit and explicit 
iterative methods used in temporal discretization for the 
approximate solutions of ordinary differential equations. 
This method was developed around 1900 by the German 
mathematicians C. Runge and M. W. Kutta  as follows [22]. 
 
 

00 )(),,( ytyytf
dt
dy

                                   (4)                  

                       
where, y is an unknown function of time, t, which we would 
like to approximate. dy/dt is the rate at which y changes as a 
function of t and of y itself. At the initial time t0 the 
corresponding y-value is y0.  
For a step-size Δt (Δt > 0), we can define 
 
 )22(

6 43211 TTTTtyy ii 



                             (5a) 

 
 ttt ii 1                                                                 (5b)      

 
 ),(1 ii ytfT                                                                (5c)         
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                                           (5d)                                                   
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2
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



                                   (5e)                                               

 
 ),( 34 TtyttfT ii                                              (5f)   

                      
        
Here yi+1 is the fourth order Runge-Kutta method 
approximation of y(ti+1), and the next value  is determined 
by the present value (yi) plus the weighted average of four 
increments,  where T1 is the increment  based on the slope at  
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the beginning of the interval; T2 is the increment based on 
the slope at the midpoint of the interval; T3 is again the 
increment based on the slope at the midpoint, and T4 is the 
increment based on the slope at the end of the interval. 
While averaging the four increments, greater weight is 
given to the increments at the midpoint [22].  
 In this work, Euler's method is used for numerical 
solving of ODEs because of its simplicity. 
 
Mechanism of Oscillating Reaction 
 Lotka-Volterra model. One of the simple models for 
oscillating reactions was proposed by Lotka in 1920 [23]. 
This model has not been seen yet in real cases, though it is 
simple model to understand the oscillating reactions. A 
series of models derived from Lotka models have been 
proposed. One of them is Lotka-Volterra model. This model 
contains two autocatalytic reactions as Eqs. (6a) and (6b): 
 
 A  + X  →  2X                                                              (6a) 
                                                            
 X  + Y  →  2Y                                                              (6b) 
                                              
 Y  →  B                                                                        (6c) 
 
The overall balance of the reaction is as A        B, where B 
is the final product. Considering that the concentration of A 
is constant, the model contains only two variables X and Y 
and a final product B. The system of differential equations 
of this model can be written as Eq. (7): 
 
 

YXXA
X cckcck

dt
dc

21                                                   (7a) 

 
 

YYX
Y ckcck

dt
dc

32                                                  (7b)                           

                                           
 

Y
B ck

dt
dc

3                                                                    (7c) 

                                                             
 

XA
A cck

dt
dc

1                                                              (7d) 

                
In  order  to  obtain  concentration-time profiles of X, Y and 
B, Euler method was used for numerical solving as Eq. (8): 
 

 
 

  tcckcckct
dt

dccc
iiiiii tYtXtXAtX

X
tXtX 

  1111 ,1,2,1,,,
       

                                                                                           (8a) 
 

  tckcckct
dt

dccc
iiiiii tYtYtXtY

Y
tYtY 

 11111 ,3,,2,,,
    

                                                                                          (8b) 
 

tckct
dt

dccc
iiii tYtB

B
tBtB 

 111 ,3,,,
                         (8c) 

 
These equations were used to simulate Lotka-Volterra 
model of oscillating reaction using Microsoft Excel macro. 
Since our focus is on intermediate species we avoid  
bringing the rate equations related to other species in two 
next models. 
 
The Brusselator Model (Bray-Liebhafsky Model) 
 The Brusselator model was proposed by Prigogine and 
his collaborators in 1967 at Free University of Brussels. 
This model was created for the explanation of the 
mechanism of Bray-Liebhafsky reaction  proposed by Bray 
and  Liebhafsky at University of California, Berkeley [24]. 
This model is one of the oscillating reactions which can be 
seen in real cases [25]. The reaction mechanism is as Eq. 
(9):     
 
 
 A   →  X                                                                      (9a) 
 
 2X  + Y  →  3X                                                            (9b) 
                                                                       

B  + X  → Y  + P                                                         (9c)                                                 

                                                      
 X  →  Q                                                                       (9d) 

                                                                         
This model contains only one autocatalytic reaction (Eq. 
(9b)). 
Because A = Q, the overall balance of mechanism can be 
written as Eq. (10):  
 

B         P                                                                      (10) 
 

k1 

k2 

k3 

k1 

k2 

k3 

K4 
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In the case of the Bray reaction, A and Q correspond to 
HIO3; B and Y correspond to H2O2 and HIO, respectively, 
and P corresponds to O2.  
 The variables of the model are the concentrations of X 
and Y species. The differential equations of the system are 
as Eq. (11); 
 

 
XBXYXA

X ckcckcckck
dt

dc
43

2
21                      (11a) 

 

 
BXYX

Y cckcck
dt

dc
3

2
2                                         (11b) 

                            
In order to obtain concentration-time profiles of X and Y, 
Euler method was used for numerical solving as Eq. (12): 
 

  tckcckcckckct
dt

dc
cc

iiiiiiiii tXtBtXtYtXtAtX
X

tXtX   1,4,,3,
2

,2,1,,, 1111111

                                                                                        (12a) 

  tcckcckct
dt

dccc
iiiiiii tBtXtYtXtY

Y
tYtY 

 111111 ,,3,
2

,2,,,
                                                                                                              

                                                                                        (12b) 
 
These equations were used to simulate Brusselator model of 
oscillating reaction using Microsoft Excel macro.  
 
Belousov-Zhabotinsky Oscillating System 
 The BZ reaction was described by Boris Belousov in 
1951. However, 10 years later, Anatol Zhabotinsky could 
show its oscillatory behavior by addition of the redox 
indicator ferroin, providing quite visible color changes upon 
system oscillations [26-28]. Different models have been 
proposed for BZ oscillating reaction [28,29]. Oregonator 
model is one of the well understood mechanisms for the BZ 
reaction [30]. This reaction involves the oxidation of an 
organic compound (usually malonic acid) by bromate ion in 
concentrated sulfuric acid. This reaction is catalyzed by 
traces of transition metal ions that possess two oxidation 
states differing in a single electron. Various simplified 
model have been proposed for this reaction. Model contains 
five steps and three variables as Eq. (13): 
 
 A  + Y  →  X                                                             (13a) 
 
 X  + Y  →  P                                                              (13b) 

 
 
 B  + X  → 2X  + Z                                                     (13c) 
 
 2X  → Q                                                                    (13d) 
 
 Z  → Y                                                                       (13e) 
 
Eq. (13c) shows the autocatalytic step of this model. The 
overall reaction, obtained by adding reactions (13a), (13b), 
(13d) and twice (13c) and (13e), is as Eq. (14): 
 
 A  + 2B  → P  + Q                                                      (14) 
 
The usual variable identifications are: A = BrO3

-, X = 
HBrO2, Y = Br-, Z = Ce4+, P = BrCH(COOH)2 or HOBr, 
and B = CH2(COOH)2. 
 The quantities X, Y and Z are dynamic variables 
corresponding to intermediates, while A and B are reactants 
whose concentrations are usually assumed to be constant. In 
addition, P and Q are products. 
 The system of differential equation for intermediates of 
the model is Eq. (15): 
 
 
 2

4321 2 XBXYXYA
X ckcckcckcck

dt
dc

                    (15a) 

 
 

ZYXYA
Y ckcckcck

dt
dc

521                                    (15b)                               

 
  

ZXB
Z ckcck

dt
dc

53                                                    (15c) 

                                        
Concentration-time profiles of X, Y and Z can be obtained 
by numerical solving of differential equations using Euler 
method as Eq. (16): 
 

  tckcckcckcckct
dt

dccc
iiiiiiii tXBtXtYtXtYAtX

X
tXtX  

2
1,4,3,,2,1,,, 2

111111

                                                                                         (16a) 
 
 

  tckcckcckct
dt

dccc
iiiiiii tZtYtXtYAtY

Y
tYtY 

 111111 ,5,,2,1,,,
                                                       

                                                                                        (16b) 
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K4 
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  tckcckct
dt

dccc
iiiii tZtXBtZ

Z
tZtZ 

 1111 ,5,3,,,
 

                                                                                        (16c) 
 
These equations Eqs. (16a, b and c) were used to simulate 
Oregonator model of oscillating reaction using Microsoft 
Excel macro.  
 
EXECUTION  
 
 A rather simple “Macro” allows one to simulate these 
three models in the same way. Here, we explain their 
simulations. 
 
Lotka-Volterra Model 
 The initial concentration value of reactant A and rate 
constants (from K1 to K3) for this model are defined in the 
C3 and from the C5 to C7 cells, respectively. The time step 
for calculations is defined in cell C4. All these parameters 
can be changed at will. Then, the initial concentrations of 
variable species X, Y and B are defined in B11, C11 and 
D11, respectively. The X and Y species play the role of 
intermediates in the Lotka-Volterra model, and B is the final 
product. 
 In Microsoft Excel, single cells containing values can be  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
defined as a new name other than its address.  It is possible 
by clicking Define Name on the Formulae tab. As an 
example, the initial concentrations of reactant A in cell C3 
was defined A0. This definition process was used to define 
rate constants and the time step with suitable names as can 
be seen in the Microsoft Excel file (Appendix 1). 
 To calculate the concentrations of the intermediates (X 
and Y) and B at each time step of the reaction, we used 
Euler’s method (a Numerical method) for solving the 
corresponding differential equations in the Excel worksheet. 
Hence, we wrote the formulae of Euler’s method for X, Y, 
and B species in B12, C12 and D12, respectively, using Eq. 
(6). The formulae can be seen by double clicking in the 
mentioned cells of file. As an example, the formula for 
calculating the concentration of B is shown in Fig. 1. Two 
graphs were also prepared to show the concentration of 
intermediates versus time (graph a in Fig. 1) and versus 
each other (graph b in Fig. 1). 
 Writing a subroutine (called a macro in Excel) allows us 
to carry out as much iteration as we wish each time to 
execute. To write the macro, we go to the “Developer” tab. 
(If never previously used, the Developer tab will not show; 
one would need to go to File\Options\Customize Ribbon 
and  tick the Developer box on  the  right  hand  panel).  It is  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Fig. 1. Initial appearance of the simulation of the Lotka-Volterra model (concentration of the intermediates vs. time  
              (a) and vs. each other (b)). 
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worth noting that if the user has not previously used macro, 
the macro is not run and one should go to the Developer 
tab\macro security and active the enable all macro options. 
 Upon clicking “Record Macro,” a new dialog box will 
open. The default name (Macro1) can be left as is or one 
can choose a name for this subroutine. A code that begins 
the program is the Ctrl key+an alphabet key (either lower 
case or upper case); this alphabet key must be now chosen. 
We choose l, so that when Ctrl+l is entered, the macro will 
begin execution. Clicking OK will close the dialog box and 
we can proceed with recording the macro. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 The cells B12:D12 are selected and dragged down into 
the next row (B13:D13), and then the cells B13:D13 are 
selected and dragged down into the next row (B14:D14). 
These operations are repeated for the 20 next rows. This is 
all we need, so by clicking on “Stop Recording,” the 
recording stops. Executing the macro at this point will 
contain only a very limited time after starting the reaction, 
while the speed of execution is relatively high; therefore, 
the macro must be modified. To do so, by clicking the 
“Macros” button, a dialog box opens (our specific macro 
will  already  be  highlighted),  and  by  clicking  the  “Edit”  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 2. The macro window as it appears (a) before and (b) after editing. 
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button, modification can be started. Then, we change the 
last cell address in the third line and after “Destination = 
Range” (D13) into D50 and in the next similar lines into 
D100, D150, D200,… until D1000 with 50 row  increments. 
Additionally, in order to decrease the speed of execution we 
can insert pause orders after each iteration. Therefore, the 
modified  macro  contains  the entire times of reaction and a 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
suitable execution speed. The modification process of 
macro 1 is shown in Fig. 2. After this modification our 
macro, macro 1, is ready to simulate the Lotka-Volterra 
model of oscillating reaction by pressing Ctrl+l (Appendix 
1). Figure 3a shows the oscillating concentration profiles of 
intermediates X and Y for given values of initial 
concentration   and   rate  constants.   To  clearly  show   the 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Fig. 3. (a) Oscillating concentration profiles of intermediates X, and Y for given values of the  initial   
           Concentration and  rate  constants  and  (b)  oscillating  plot of  intermediates X  and Y in the  

                     Lotka-Volterra model. 
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oscillating process, the concentration of two intermediates 
was plotted versus each other, named the oscillating plot, 
and is shown in Fig. 3b. The oscillating plot shows the 
concentration effect of the two intermediates on each other 
and shows how the corresponding reaction speeds up to 
produce the relative intermediate. In order to easily study 
the effect of parameters such as rate constants and initial 
concentration of reactants on simulated oscillating reaction, 
another Microsoft Excel file was prepared that a has  scroll 
bar for each parameter. Figure 4 shows a snapshot of this 
file. These scroll bars let the users easily investigate the 
effect of parameters and visualize these effects. Appendix 2 
is a Microsoft Excel file that has scroll bars for each 
parameters and variables. To add a scroll bar for a 
parameter in Microsoft Excel, the insert button is selected 
from the developer tab; a list of different controls will 
appear. The scroll bar panel will appear in the Microsoft 
Excel sheet by selecting the scroll bar (form control) button.  
Linking to the cells and defining scroll parameters is 
possible by right clicking on the scroll bar panel and 
selecting format control\control. 
 We also use the Runge-Kutta method to solve the 
differential equations of our simplest model (Lotka- 
Volterra model). At first, the initial concentration value of 
reactant A, and rate constants (from k1 to k3) for this model 
are defined in the J3 and from the J4 to J6 cells, 
respectively. The time step for calculations is defined in cell 
J2. Then, the initial concentrations of variable species X and 
Y are defined in G11 and L11 respectively. To calculate the 
concentrations of the intermediates (X and Y) we wrote the 
formula of Runge-Kutta method for X and Y species in 
C12:G12 and H12:L12, respectively, using Eq. (5) and rate 
equations (Eq. (7)). The cells C12:G12 and H12:L12 are 
selected and dragged down into C1011:F1011 and 
H1011:L1011. Finally, we draw the concentration figure of 
X and Y versus time. Appendix 3 is a Microsoft Excel file 
at which differential equations of Lotka-Volterra model 
have been solved using Runge-Kutta method and the model 
has been simulated. 
 
Brusselator Model 
 Similar to the previous simulation, the initial 
concentrations of reactants A and B and the rate constants 
(from k1 to k4) for this model are defined in cells C3 and C4 

 
 
and from J2 to J5, respectively. The time step for the 
calculations is defined in cell C5. All these parameters can 
be changed at will; then, the initial concentrations of 
variable species X, and Y that play the role of intermediates 
in the Brusselator model are defined in B9 and C9, 
respectively. 
 To calculate the concentrations of the intermediates (X 
and Y) at each time step of the reactions in the Excel 
worksheet, Euler’s method was used. The formulae of 
Euler’s method for X and Y species were written in B10 and 
C10, respectively, according to Eq. (12). 
 To write the macro, the Developer tab must be selected. 
By clicking on Record Macro, a new dialog box will open. 
The letter r is selected to run the Brusselator model, By 
clicking on Ok the recording of the macro will start, so that 
when Ctrl+r is entered, the macro will begin execution. 
 The cells B10:C10 are selected and dragged down into 
the next row (B11:C11), and then the cells B11:C11are 
selected and dragged down into the next row (B12:C12). 
These operations are repeated for the next 18 rows. By 
clicking on “Stop Recording,” the recording stops. To 
modify this macro, we click on the “Macros” button and 
then the “Edit” button. Then, we change the second cell 
address in the third line and after entering “Destination = 
Range” (B11) into C120 and the next similar lines into 
C240, C360, C480, … until C2160 with 120 row 
increments, and in order to decrease the speed of execution 
we insert pause orders after each iteration. Therefore, the 
modified macro contains the entire times of reaction and a 
suitable execution speed. Appendix 4 is a Microsoft Excel 
macro file that can be used to simulate the Brusselator 
model of the oscillating reaction using defined mechanisms 
and parameters. This macro can be run by the Ctrl+r short 
cut. Appendix 5 is another Microsoft Excel file that can be 
used to simulate the Brusselator model of an oscillating 
reaction. The scroll bar is placed in this file for the initial 
concentration and rate constants to easily study their effects 
by the users. Figure 5 shows a print screen from this file. 
Figure 6 shows the oscillation in concentrations of the 
intermediates for the given values of rate constants and 
predefined initial concentration of the reactants. 
 
Belousov-Zhabotinsky Model 
 The  initial  concentrations of reactants A and B and rate 
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constants (from k1 to k5) for this model are defined in C2 
and C3 and from J1 to J5, respectively. The time step for 
calculations is defined in cell C4. All these parameters can 
be changed at will. Then the initial concentrations of 
variable species Y, X and Z that play the role of 
intermediates in the Oregonator model are defined in B7, 
C7 and D7, respectively. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Similar to the previous simulations, to calculate the 
concentrations of intermediates (Y, X and Z) at each time 
step of the reactions, the formulae of Euler’s method for Y, 
X and Z species (Eq. (16)) are written in B8, C8 and D8, 
respectively, in Microsoft Excel worksheet. In addition, two 
graphs, a and b, are prepared in order to plot the 
concentration of the intermediates. To write the macro, we 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Fig. 4. Evolution the effects of corresponding parameters on oscillating behavior of species of the Lotka-Volterra  
                 model by using of scroll bars in the spreadsheet. 
 
 

 

Fig. 5. Evolution the effects of corresponding parameters on oscillating behavior of intermediates of the Brusselator   
               model by using of scroll bars in the spreadsheet. 
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go to the Developer tab and click Record Macro. Ctrl+b is 
chosen as the short cut, so that when Ctrl+ b is entered, the 
macro will begin execution. By clicking on Ok, the macro 
recording starts. The cells B8:D8 are selected and dragged 
down into the next row (B9:D9), and then cellsB9:D9 are 
selected and dragged down into the next row (B10:D10). 
These operations are repeated for the next 20 rows. The 
recording of the macro is stopped by clicking on the “Stop 
Recording” button.  To  modify  the  macro,  the second cell 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
address in the third line and after “Destination = Range” 
(D9) is changed  into D150 and the next similar lines into 
D300, D450, D600, … until D3000 with 150 increments, 
and to decrease the speed of the execution, a pause is 
inserted after each iteration. Similar to the two other 
simulations, the modified macro contains the entire times of 
reaction and a suitable execution speed. 
 Appendix 6 is a Microsoft Excel macro file that can be 
used  to  simulate  the  Oregonator  model  of BZ oscillating 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Fig. 6. (a) Oscillating concentration profiles of intermediates X and Y for given values of the initial  
           concentration and rate constants and (b) oscillating plot of the  intermediates X and Y in the  

                      Brusselator model. 
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     Table 1. Temporal Evolution of Oscillating Behavior for the Intermediates of Oregonator Model with Different Values  
                    of  K1  and  with  Constant  Values  of: K2 = 0.5;  K3 = 1; K4 = 0.045; K5 = 0.025; Time  Step = 2.5 s and  with   
                    Constant Concentration of: A0 = 0.05 M and B0 = 0.1 M 
 

Value of 
parameters 

 
Concentration profile 

 

 
Oscillating plot 

 
K1 = 0.02 
 

  
K1 = 0.15 
 

  
K1 = 0.2 
 

  
K1 = 0.4 
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   Table 2. Temporal Evolution of Oscillating Behavior  for the  Intermediates of  Oregonator  Model  with Different   
                  Values of A0 and with Constant Values of: K1 = 0.15; K2 = 0.5; K3 = 1; K4 = 0.045; K5 = 0.025; Time Step  
                   = 2.5 s and with Constant Concentration of: B0 = 0.1 M 
 

Initial 
concentration of 
reactant (M) 

Concentration profile 
 

Oscillating plot 
 

A0 = 0.005 
 

  
A0 = 0.02 
 

  
A0 = 0.065 
 

  
A0 = 0.1 
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reaction using defined mechanisms and parameters. This 
macro can be run by pressing the Ctrl+b short cut. In 
another Microsoft Excel file, the scroll bar is placed for the 
initial concentration and rate constants to easily study their 
effect (Appendix 7). Table1 shows the simulated 
concentration profiles of  three intermediates X, Y and Z, 
and the oscillating plot  for two intermediates X and Y for 
different given values of the rate constant of the first step of 
mechanism, k1. Other rate constants and initial 
concentrations are kept constant for the mentioned 
simulations. To investigate the effect of the initial 
concentration  of  reactant  A, in the Oregonator model, four 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
models were simulated with different initial concentrations 
of A and a constant concentration of other reactants. Table 2 
shows  the simulated concentration profiles of the three 
intermediates X, Y and Z, and the oscillating plot for the 
two intermediates X and Y for different given values of the 
initial concentration of A. 
 
Nonlinear Least-Squares Curve Fitting with 
Microsoft Excel Solver 
 Least squares curve fitting, as a powerful tool that is 
widely available in spreadsheets, provides a simple means 
of    fitting   experimental    data   to   linear   and   nonlinear 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 7. The solver window. 
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functions. The procedure is so easy to use and its mode of 
operation is so obvious that  could be an excellent way for 
the students to learn the underlying principle of least 
squares curve fitting [31]. With Solver, it is possible to find 
an optimal (maximum or minimum) value for a formula in 
one cell-called the objective cell-subject to constraints, or 
limits, on the values of other formula cells on a worksheet. 
Solver works with a group of cells, called decision variables 
or simply variable cells that participate in computing the 
formulas in the objective and constraint cells. Solver adjusts 
the values in the decision variable cells to satisfy the limits 
on constraint cells and produce the result you want for the 
objective cell. To optimize the parameters such as rate 
constants, after simulation of models, we can use the solver. 
For example we perform the fitting for Lotka-Volterra 
model. Residual defined as Eq. (17). 
 
 )()( calculatedyobservedyr iii                               (17) 

 
The least squares criterion is to find the values of rate 
constants using the concentration values of x and y, in Eqs. 
(6a) and (6b) for each time step, which minimize the sum of 
square of residuals: 
 
 2

1
)( i

n

i
rSSQ  

                                                           (18) 

                                                       
where n is the total number of points.  The best values of k1, 
k2 and k3 that minimize the SSQ are found by Solver. To 
perform the nonlinear least squares curve fitting, the 
measured data must be pasted in spreadsheet. The 
concentrations of X and Y which were simulated using 
Lotka-Voltra model in appendix?  were copied and pasted in 
new spreadsheet as values in B13:B1013 and C13:C1013 
for X and Y, respectively. The next step is calculating the 
concentrations of X and Y using approximately estimated 
rate constants. The initial concentration value of reactant A 
and estimated rate constants (from k1 to k3) for this model 
are defined in the J2 and from the J4 to J6 cells, 
respectively. The time step for calculations is defined in cell 
J3. Then, the initial concentrations of variable species X and 
Y are defined in D13 and E13 respectively. To calculate the 
concentrations of the intermediates (X and Y) we wrote the 
formulae of Euler’s method for X and Y species in D14 and  

 
 
E14, respectively, using Eq. (6). The cells D14 and E14 are 
selected and dragged down into the D1013 and E1013.  
Temporarily assign the values 0.07, 0.8 and 1.3 to k1, k2 and 
k3, respectively. In column F, sum of squares of X and Y 
residuals was written in cell F13 and dragged down to 
F1013. For example, F14 = ((D14 - B14)^2 + (E14 -
C14)^2). In cell F1014, sum of the F13:F1013 cells was 
written and used as SSQ.   
 The least squares criterion is to find the values of k1, k2 
and k3 that minimize the sum in cell F1014. Microsoft Excel 
provides a tool called Solver that handles this problem in a 
manner that is transparent to the user. Solver is invoked in 
different manners by different versions of the software. In 
version 2010, if the Solver command or the Analysis group 
is not available, you need to load the Solver Add-in 
program. By clicking on the solver in Data tab the screen in 
Fig. 7 appears. If cell F1014 was highlighted prior to calling 
Solver, then “$F$1014” automatically appears in the upper 
left dialog box that says “Set objective”. If other cell was 
highlighted, enter F1014 in the Set objective box. Since we 
intend to minimize the SSQ, calculated in cell F1014, click 
“Min” on the second line beside “to”. Finally, write “J4, J5 
and J6” in the dialog box labeled “By Changing variable 
Cells”. Now click “Solve” and you have just asked the 
software to set the value of cell F1014 to a minimum by 
changing the values in cells J4, J5, and J6. After finishing 
Solver task in a few seconds, the value of J4, J5 and J6 cells 
changes to 0.1, 1 and 1.5, respectively. When we have only 
one of the species (X or Y) concentration data the same 
steps allow us to obtain the optimum values of k1, k2 and 
k2, k3 by using X and Y concentration values, respectively. 
Appendix 8 is a Microsoft Excel file that is ready for least 
squares fitting of rate constants of Lotka-Volterra model. To 
obtain the optimum values of the rate constants we can use 
this fitting for two other models. 
 
CONCLUTIONS  
 
 The present study describes the simulation of oscillating 
reaction models in a simple and accessible environment and 
reveals the capabilities of spreadsheets, specifically 
Microsoft Excel. The simulations show the oscillating 
behavior of intermediates concentrations as in real 
experiments.   In   addition,   the  effects   of   corresponding  
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parameters specifically species concentrations and rate 
constants on oscillating behavior are studied very easily and 
affordably.  
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